LIFE in SoC 

Module Selection

The School of Computing offers a large number of courses, and allows students to select modules on their own.  Before you do online registration to select modules for your first semester, it is recommended that:

1. You have a good knowledge of the courses being offered in our faculty.

2. Take into consideration what you would like to focus on (i.e., whether you would like to focus on CS, IS or IT modules).

Hint: You can trace your way down from the fourth year to the first year, selecting the modules that you want to take in the fourth year and then see what are the prerequisites required for them and try and do all those are required first.

The cross faculty modules are provided by faculties other than SoC. These modules not only enhance your knowledge in different fields, but also let you dip into subjects that you are interested in.  Some CFM modules are graded while others are on a pass/fail base.

Things to remember:

1. Read the course information of all the modules offered by SoC and see how much workload you are suggested to have in each semester, and check how much workload you would actually like to take.

2. Think about in which area you would like to develop and then select your modules appropriately accordingly. 

3. Do not take too many modules that would not be counted towards your total modular credits at graduation.

4. As you are required to have at least 135 modular credits (including honors year), you should spread your modular credits over all your semesters and on an average try to do 18 modular credits every semester.

5. Always keep in mind that if you perform bad or fail in one of the courses, you are likely to have a very upset schedule for the rest of your life in SoC, so best of luck, organize your courses and do well!

6. If you are not sure about how to choose the modules and fulfill their prerequisites without burdening yourself, you should talk to our counselors who will guide you along the way. 

7. You should also do your module registration on time (pay attention to your e-mails and notices in SoC). 

Time Management

One of the major problems students usually encounter in university is how to manage their time properly. One typical routine of a student could be: stay up till late in the night doing nothing, oversleep in the morning, skip lectures and go for tutorials with totally blank mind. These students, during the examination days, are completely stressed out and land up being blur about their subjects and score poorly. 

As one saying goes, “early to bed, early to rise makes a person healthy, wealthy and wise”.   Now here are some points to how to make full use of your time:

1. Make a schedule for your whole semester, which tells you what you are going to do and accomplish periodically.

2. Make a schedule for your whole day, which tells you what you are going to do daily.

3. Always attend your lectures so that you do not have to waste hours just trying to catch up what has been taught during lecture time. 

4. Always study in between your classes and refresh in your mind what was just taught in the last lecture. 

5. Do your tutorials and homework on time, and do not wait until the last minute.

6. Relax your mind regularly so that your efficiency in study will remain high, but do not addict to computer and video games.

7. Take part in hall activities only when you think you can manage it, remember that study should always take priority.

Remember that you have as much time as anyone else does, so if others can make all their jobs done, why not you?

 Study in the School of Computing

In the School of Computing, sooner or later, you will have to endure tougher courses. For students who do not have any background in programming or computer, you may probably start with difficulties, yet you can still exceed in your study as long as you do care for it.  

Attitude counts

If your goal is to study, you will enjoy the courses (any course actually), and will be rewarded later as you take most of the high level courses. If your goal is to pass, without the intent to learn, you may end up copying, without knowing why things are done the way they are. But later, you will have problems, with the quizzes, with practical examinations (which you will have to take in almost every programming courses), with the final examinations, with later courses, or even with your future employment. Therefore, be an independent learner, and be proactive in your study, and you will soon get the payoff. 

Good way of learning helps

If you do want to study, and are still having problems, you can try to clarify whenever you see any of the lecturers or tutors. Alternatively, you can come during the consultation hours (usually every lecturer and tutor has his or her own consultation hours). Study is much more than just attending lectures and tutorials, and do ask questions and try to figure out why things are done in the way they are.

Some of the courses in the School of Computing are under LoD system (Lecture-on-Demand), which means there is no live lecture during the semester.  Instead, CDROMs will be distributed to everyone who takes the module.  Do view the CDROMs according to the course schedule; otherwise you will be totally lost in the module in weeks’ time.

The UNIX Operating System TC “The UNIX Operating System”
Why Learn UNIX 

It is the multi-user operating system that runs our school computers and the one that contains your account. This is the operating system where you access your email and read the news from the school Bulletin Board System (BBS), If you know the basics of UNIX commands you can manage your files well as well discuss any issues on the BBS. Learn UNIX, it is easy!!!

UNIX Is Easy To Learn 

Unlike the Windows 3.1 and Win95 operating systems in our home PCs that use graphical user interfaces, UNIX is text-based and can appear quite intimidating to some people. However I assure you if you spent some time reading this document, you will be in no trouble navigating through UNIX. 

Introduction and Convention

Before you begin reading this document, here are some conventions to follow when reading this text.

· Text printed in Courier New Font represents what you will see on your terminal screen.

· Text printed in Bold represents what you are expected to type when prompted to.

· Text printed in Italics is just things you should take note of while reading this document.

· Text in a box refers to special keys like Enter on the keyboard which you are expected to type.

There will be also references to variables in the form <name of variable> which requires you to replace the name with an actual command or key that the name represents. For example, <printer id> expects you to replace this occurrence with an actual printer id like “dmll214” in the context where <printer id> occurs.

Getting Started tc “Getting Started” \l 2
Changing Your Passwords 

It is good to have your password changed often. For that type yppasswd Enter at the $-prompt. You will also be required to change your passwords when you first log in.

You will be asked to key in your old password and then your new password twice. Choose any combination of 8 characters and/or digits. UNIX is a cranky old nagger where it comes to passwords, so mix UPPERCASE characters and digits generously with the usual lowercase letters. For example PaSsw4Rd makes a decent password  (think of something similar in style, DO NOT use the above password for your own!)

An Introduction to UNIX Shell

The first concept that you will be familiar with is files and folders in UNIX. In future, your programs will be stored in files as well as your data, assignments, love letters etc. Think of your files as pieces of paper on which you write something. 

The next natural question is “How do I find these pieces of paper?” in other words, “how are they organised?”  You can think of the UNIX system as being gigantic filing cabinet with many folders that hold the files you want. These folders are organised in a hierarchical fashion. Folders may in turn contain folders within them and so on.

UNIX has one big folder that holds everything. It is known as the root and is represented by the “ / “ symbol. Any folder directly below the root has the name  

/<level 1 folder name> . Folders, which are below this folder, have the name 

/<level 1 folder name>/<level 2 folder name> and so on .  This is known as the pathname of the folder. Hence the structure of the UNIX file system is a tree as shown:
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Basic UNIX Commands tc “Basic Unix Commands” \l 2
Now you can manipulate your files and data through UNIX commands. The typical structure of these commands is:


$ <command>   <options>   <parameters> Enter     
<command> is the name of the command you want to use .

<options> are usually (not always!) a “-“ followed by some alphabet or digit. For example, “-P”.

<parameters> typically refers to a list of filenames or folder names that you want to pass to the command . 

Enter is the key you hit after typing in the command. Henceforth, this key will be implied to be hit at the end of all commands in UNIX. In addition, note that UNIX is case sensitive. So ‘pwd’, ‘Pwd’ and ‘PWD’ are different as far as UNIX is concerned.

Getting Help – the man command

Online help in UNIX is in the form of man pages which consist of an online version of the Unix documentation set. The “man” command is used to access the man pages. The basic syntax is 

$ man <topic>

where “topic” is the name of the command or filename that you need help with. For example, man ls will display help for the command ls. To find out more about man, type man man at the command prompt. You are also strongly encouraged to read the following man pages:

$ man rules - rules & regulations on the school’s computer systems

$ man policies - policies on the school’s computer systems

$ man printers - help on printing with the school’s printers

Where am I? – The pwd command

Occasionally, you might want to know “ what folder am I looking ?”. UNIX always starts you off at what is known as your home directory. This will be /home/stu97/<your user id>. As you move around in the folder system , you might get lost , hence the “pwd“ command .

wongwf@decunx:~[501]$ pwd
/home/stu98/wongwf
“pwd” stands for present working directory . This command essentially tells you which folder you are in.

What is in my directory? – the ls command

Now that you where you are, the next important thing is to be able to see what files and folders you have in the current folder.

Type ls.

wongwf@decunx:~/News[511]$ ls
ManPages1  Print      eye        vacation
If you prefer to have a more detailed output, type ls –l. This means you have used your first <option> . You should see something similar to the following:

wongwf@decunx:~/News[512]$ ls -l
total 6

-rw-------   1 wongwf iscs97        939 Apr 24 15:14 ManPages1

-rw-------   1 wongwf iscs97       1182 Apr 17 21:42 Print

-rw-------   1 wongwf iscs97       1372 Apr 17 21:43 eye

-rw-------   1 wongwf iscs97        980 May 13 14:24 vacation
 
You distinguish files and folders by looking at the very first character of each column. Should be a “d”(which stands for directory) or a “-“ which stands for a file. There are hidden files. To view them use the “-a” option for “ls”. Type ls –la. You will see something similar to the following:

wongwf@decunx:~/News[514]$ ls -la
total 22

drwx------   2 wongwf iscs97       8192  May 13  14:24    .

drwx--x--x  25 wongwf iscs97       8192  Jun  1  14:26    ..

-rw-------   1 wongwf iscs97       939  Apr 24   15:14    ManPages1

-rw-------   1 wongwf iscs97       1182  Apr 17  21:42    Print

-rw-------   1 wongwf iscs97       1372  Apr 17  21:43    eye

-rw-------   1 wongwf iscs97       980   May 13  14:24    vacation
Hidden files in UNIX are prefixed by a “.” Symbol. By convention, the current directory “.” and parent directory “..” are also hidden. Hey! What else have you have noticed? Yes, you have combined two options together! UNIX allows you to do that. Cool huh?

How do I read my files? –   cat, more & less
To see your file called <filename>, type cat filename

It is often not useful to have a hundred page document flash right pass you when you “cat” it. This is where “more” and “less” comes in. “more” and “less” are more or less the same. They allow pages to be displayed a screen at a time. You may then press ENTER to scroll to the next line, SPACE to call up the next page, “b” to go back one page and finally ‘q” to quit from viewing the document. ”more” and “less” are friendly too , try more or less  to find out!

How do I move around? – the cd command

The change directory or “cd” command is one that you do not pass filenames as a parameter to it. Instead, you supply the names of a folder. There are three special symbols used in conjunction with this command:

”.”
represents the current directory .

”..” 
represents the parent directory of the current directory .

“~”
represents the home directory .

Hence there are several ways to use “cd” :

$ cd  <pathname>


as in cd /home/stu98/user-id/love_letters will bring you to the love letters directory in your home directory.

$ cd  <special symbol>/<path>


like cd ~/love_letters will bring me to exactly the same directory as above !

$ cd  <directory name>

brings you to the folder stored directly in your current folder with the name given as <directory name>. If I am at my home directory, typing cd love_letters will bring me to the same location as the above two examples.

$ cd is a shortcut to your home directory .

Can I make new folders? – the mkdir command

The syntax of the “mkdir” command is mkdir <pathname>/<name of new folder>. For example, if you wish to place a new folder into the new folder /home/stu97/leecw/love_letters and call it Deep_Impact, then type

$ mkdir/home/stu97/leecw/love_letters/Deep_Impact

Moving and Renaming files – mv

To rename a file

$mv <sourcefile>  <newfile>

To move files 

$ mv <source directory><destination directory>

Removing Files and Directories

“rm” and “rmdir” are the commands to remove a file and a folder respectively .Their forms are

$ rm <filename>

$ rmdir <pathname>

Use these commands with care. There is no “unremove/undelete” or recycle-bin in UNIX. If you ever accidentally removed something from your directory,  please seek help from machine room staff at S15 Level 1.

Copying Files – cp

The format is  $cp <sourcefile> <destination file>

The above will create a new file with name <destination file> that has exactly the same content as the original name <source file>.

How secure is my files and directories? And How can others read my files in my directories?

 When you type ls -l, you will most likely see something like this:

   -rw-r----- 1 marty techsupp 18417 Jun 18 15:00 memo1

The set of 10 characters on the left of the line of output indicates first the type of file, and then the access rights for the file. Each file (and directory) has three sets of access privileges, one set for the owner of the file, one set for the group owner of the file, and one set for those users who are neither of the 2 groups.

If an access rights for a particular category of user has been granted, a dash (-) will appear. The layout of the privileges is as follows, starting from the left most character:

· The first character can be ignored.

· The next 3 characters are for the read, write and execute permission for the user himself.

· The next 3 characters are for the read, write and execute permission for the group members.

· The next 3 characters are for the read, write and execute permission for the other users.

So, in the above example, -rw-r----- would mean the file can be read and written by the user himself and can also be read by users from the same group. You can use the “chmod” command to change the permission setting of your file.

As an example, chmod a+r /usr/marty/letter will add permission to read the file for the 'a' categories of users (that is, all types of users).

We can view the 'a+r' as 3 parts. The first part is to indicate which user group is to be affected. The second part is to indicate to enable or disable the permission type, which is the third part.

The following is a table for the symbols to use for the 3 parts:

User Groups:

u
owner himself

g
group members

o
other users

a
combination of the above 3 groups

Action to Take:

+
enable


-
disable

Permission Type:

r
read

w
write

x
execute

Printing Documents

 tc “Printing Documents” \l 2
There are 2 different ways to print your documents/files. One method is via the Print Manager utility, and the other is via the Unix Prompt.

PM – Print Manager

How to Invoke Print Manager

· Type ‘pm’ at the Unix prompt. 

· The Print Manager Menu Screen will be displayed with 3 frames.

· The 2 frames on the left are a list of directories and their respective files (the Directory List on the top, and the Files List at the bottom), and the Printing List on the right shows a list of files selected for printing (initially empty).

How to Select Files to Print

· Using the Arrow Keys, select the directory from which the file(s) reside in the Directory List, and press Enter.

· Press ‘tab’ to proceed to the Files List.

· Using  the Arrow Keys, select the file(s) which you wish to print and press Enter.

· Selected files to print will appear in the Printing List on the right.

· To select files from other directories, press ‘tab’ to move back to the Directory List and repeat Steps 1-3.

· To deselect files for printing, press tab to move to the Printing List. Using the Arrow Keys, deselect the files by pressing Enter.

How to Select the Output Format

· Currently, there are 2 formats available. One-Column-One-Page or Two-Columns-One-Page

· Press ‘f’ to toggle (change) the format. A pop-up screen will inform you of the format chosen.

How to Select the Printer

Different printers reside in different locations. To select a printer to use, press ‘L’ and a list of printers and their locations will be presented. Use the Arrow Keys and press Enter to make your selection.

How to Select the Font Size of the Printouts

This option is available only for the One-Column-One-Page Format.

· Press ‘x’

· You can make a selection from a list of 3 font sizes using the Arrow Keys and press Enter to confirm.

How to Print Selected Files

· Press ‘s’

· You may be prompted to select a printer

· Print Manager will confirm your print request. Press ‘q’ to abort the operation, or any other key to proceed.

· Collect your printouts (a penalty will be imposed on your limited print quota if you fail to collect them)
How to Be Informed When Printouts are Successful/Ready for Collection

You can configure Print Manager to inform you of successful/failed printouts.

· Press ‘n’ to toggle whether you want to be informed or not. (A pop-out box will inform you of the status)

· If you wish to be informed, a mail will be sent to you each time a print job is completed. This mail comes from Mr. Background.

How to Refresh the Screen

Sometimes the Print Manager screen may be filled with “gibberish”. Press CTRL-L to refresh the screen.


Printing from Unix Prompt

· Syntax: lpr –P<printer id> <filename>

· For a list of printers, type ‘man printers’ at the Unix prompt. Alternatively, each printer has a “number tag” fixed on top of them. So make a quick check to ensure the print jobs are sent to the correct printer. 

· For example, lpr –Pdmll214 x-files will send the file ‘x-files’ to the line printer at terminal room 4.

· To check the print queue (to see if your print jobs are in the queue, or just to see if the printer is really busy), type in the following command at the Unix Prompt

$lpq –P<printer id>  (note: no space after “–P”)
· To delete your print job from the print queue, 

1. Check for the print job number  (via the lpq command as stated above)

2. Type in the following command 

lprm –P<printer id> <job number>

· If you are “kiasu”, you can check the print queue again to ensure your print job is taken off the queue.

P.S. You can only delete your own print jobs from the same host you printed.


Applications

Editors

PICO -- A Text Editor tc “PICO – A Text Editor” \l 2
How to Invoke pico? 

· Syntax: pico [options] [file]

· Some options:


+n
Causes pico to start an the nth line of the file


-w
Disable word wrap (for editing of long lines)


-z
Enables ^Z (Ctrl-Z) suspension of Pico

· If file is not specified or does not exist, then a new file is created. If file exists, then pico allows you to edit the contents.

· Start typing!

How to Navigate in pico?

· Arrow keys allow for simple navigation.

· CTRL-Y
Page Up

· CTRL-V
Page Down

How to Save File

CTRL-O
You will be prompted for a file name. Press Enter to save it in current file, or key in a new file name. You will also be prompted to make a save upon exiting Pico

How to Add in contents of Another File?

CTRL-R
You will be prompted for the name of the other file. Simply type the filename relative to your home directory. Alternatively, CTRL-T will display a list of files/directories for you to choose your desired file.

How to Do a Cut & Paste?

CTRL-K 
To cut the entire line that the cursor is currently on.

· To mark out a block of text to cut, use CTRL-^ and "shade" the desired block of text using the up/down arrow keys.

· You can also use CTRL-V and CTRL-Y for marking out pages of text.

CTRL-U 
To paste whatever text that was cut by CTRL-K.

How Do I Check The Line Number You Are Currently On?

CTRL-C
Show the line number and the percentage of the file you are at.

How To Perform A Spell-Check?

CTRL-T
If any misspelled words are found, you will be prompted for a replacement. Enter the correct word and press the Enter Key to make a replacement.

How Do I Get Out of pico?

CTRL-X
If you have modified the content of the file, you will be prompted to save the file before exit.

How to Change the Default Editor 

There are quite a few document editors in Unix, such as pico, emacs, vi, vim, etc.   Following is how you can choose your preferred editor to use.

· In your home directory, use command “pico + SPACE + .profile” to go to your profile. Add the following line:

 export  EDITOR=<your preferred editor>

            into it.

· In pine, after you enter it, go to its SETUP, then go to CONFIG, find the line with heading

                   editor

      Then set the value of it to your preferred editor.

Emacs -- A Powerful Program Editor tc “PICO – A Text Editor” \l 2
How to Invoke Emacs? 

· Syntax: emacs [options] [file]

· If file is not specified or does not exist, then a new file is created. If file exists, then Emacs allows you to edit the contents.

· Start typing!

Notes:

· C- means “holding Ctrl”.

· M- means “holding Alt” (on X-terminal) or “press ESC once” (on PC).

E.g.
C-x C-f means that “holding Ctrl then press x and f”.

C-x 2 means that “press Ctrl and x at the same time, then press 2.

M-g means that “press Alt and g at the same time” (on X-terminal) or “press ESC once then press g” (on PC).

How to Open Files?

C-x C-f
You will be prompted for a file name.

How to Navigate in Emacs?

· Arrow keys allow for simple navigation.

· C-v
Page Up

· M-v
Page Down

Entity to move over
Backward
Forward

Character
C-b
C-f

Word
M-b
M-f

Line
C-p
C-n

Beginning/End of a line
C-a
C-e

Sentence
M-a
M-e

Paragraph
M-{
M-}

Page
C-x [
C-x ]

How to Save Files?

C-x C-s
You will be prompted for a file name. Press Enter to save it in current file, or key in a new file name. You will also be prompted to make a save upon exiting Emacs.

How to Search a particular string in a file?

· C-s
Search forward

· C-r
Search backward

· C-g
Abort current search

You will be prompted for a search string.

How to go to a particular line?

C-g n
Cursor goes to the nth line.

How to Work with Multiple Windows?

· C-x 2
Split window in two vertically

· C-x 3
Split window in two horizontally

· C-x 1
Delete all the other windows

· C-x 0
Delete this window

· C-x o
Switch cursor to another window

How to Delete?

Entity to Delete
Backward
Forward

Character
DEL
C-d

Word
M-DEL
M-d

Line
M-0 C-k
C-k

Sentence
C-x DEL
M-k

C-y
Yank back last thing deleted

How to Get Out of Emacs?

C-x C-c
If you have modified the content of the file, you will be prompted to save the file before exit.

If I am a professional programmer (, is there any program editor better than Emacs?

Yes!!! 

X-Emacs

X-Emacs has a user-friendlier interface. It can highlight the syntax and paren of almost all the programming languages nowadays. The basic commands of X-Emacs are same with Emacs.

If you want to use X-Emacs, please add following instruction in your .profile at home directory.

/opt/SUNWspro/bin/xemacs


Email

PINE - Program for Internet News and Email tc “PINE – Program for Internet News and Email” \l 2
How Do I Invoke pine?

Type pine at the unix prompt, and the Main Menu will be displayed.

How To Navigate In Pine

You can use the arrow keys to scroll line by line, or use the spacebar and the '-' key to scroll by page. The key CTRL-C is used to cancel any wrong request/command entered.

How To View Mails

1. From the Main Menu, select Folder List and press Enter

2. A List of Folders will be shown. Select one of the folders and press Enter. Usually, New Mails reside in your INBOX.

3. A List of Mails in the selected folder will be presented. Select one and press Enter
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The Content of the Mail will be displayed

5. To view the next or previous mail in the folder, press 'n' or 'p' respectively.

6. To return back to the List of Folders, press 'l'.

7. To return back to the Main Menu, press 'm'.

How To View File Attachments In Mails

Press 'V' to view, and 'E' to exit the attachment viewer.

How To Save Mails

After viewing your mail, here's how to save them:

1. Press 's' to save

2. You will be asked to save it in a (separate) folder. Type in the name of the destination folder

3. If it does not exist, you will be asked if you want to create it. Press 'y' to agree, 'n' otherwise

How To Save Mails Into Files (Export)

To save a mail as a file in a directory (instead of a folder in Pine),

· Press 'e' to Export

· You will be asked for a filename. Key in a filename relative to your home directory.


How To Mail Someone

· Select 'Compose Message' from the Main Menu
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You will see 4 fields:

a) 'To:' field: key in the email address of the recipient(s) here

b) 'Cc:' field: key in the email address of secondary recipients (optional)

c) 'Attchmnt' field: to attach a file (see later)

d) 'Subject' field: A brief description of your mail

· Type in your message in the pico-like text editor

· To send, press CTRL-X
How To Reply A Mail

After reading a mail and you want to reply to it, 

· press 'r' to Reply, 

· If there are more than one recipient in the mail, you will be asked if you wish to reply to everybody. Press 'y' if you wish to do so, 'n' otherwise

· You will be asked if you wish to include the original message. Press 'y' if you wish to do so, 'n' otherwise

· Type in your reply, and press CTRL-X to send.

How To Forward A Mail

· After reading a mail and you wish to send a copy to somebody else, 

1) Press 'f' to Forward

2) Type in the email address of the recipient(s)

3) Type in a message if you wish

4) Press CTRL-X to send

How To Add In Contents From A File

· When you are typing your mail, 

1) Press CTRL-R and you will be asked for a filename

2) Type in the filename relative to your home directory, or 

3) Press CTRL-T for a list of directories/files.

How To Attach A File Separated From The Mail

· In the 'Attachment' Field, 

1) Enter the filename relative to your home directory, or

2) Press CTRL-T for a list of directories/files

How To Delete/Undelete A Mail

· You can:

· Press 'd' when you are viewing the mail, or

· Press 'd' when you are viewing a listing of mails in the folder

· To undelete a mail, press 'u' instead.

· When exiting Pine, you will be asked if you wish to 'Expunge' deleted mails in a particular folder. By Expunging, you will not be able to undelete the mails marked for deletion. Press 'y' if you wish to do so, or press 'n' otherwise.

How To Use The Address Book

· You may wish to store the addresses of people you mail often, and so the next time you mail them, you can type in a nickname that represents that group of people.

1) Press 'T' while reading your mail. A list of addresses that appears in the mail will be displayed

2) Mark those that you wish to add in your address book. One way is to press 'l', then press 'x' to mark the boxes besides the address.

3) Press 'T' when finished marking

4) You will be asked to enter a nickname for this group of addresses. Add in any additional information. Press CTRL-X to save and exit

· The next time you want to email this group of people, you can just type in the nickname instead of the individual addresses.

· You can also store addresses manually by selecting 'Address Book' from the Main Menu. You can add a list of addresses to an existing nickname by pressing 'A'.

How To Add A Signature Line(S) To Outgoing Mail

· Usually, you will like to sign off your mail with 'Best Regards' and the likes, together with any additonal information you will like the recipient(s) to know (like homepage URL etc).

· Do the following with any text editor:

· Create a file called .signature (note the dot)

· The contents of the above file should contain your signature line(s).

· Please limit your signature to 8 lines.

· Thus whenever you compose or reply to a mail, your signature line(s) will automatically appear.

How Do I Get Out of pico?

· Press “Q” to exit to UNIX prompt.

Others

There are some other soft wares available for checking mail as well. “Mutt” is one that works on UNIX platform. “Outlook Express” can also be used to retrieve mails from the SoC account. Please refer to the section on Dialup Services for the settings of mail servers.


NEWS

BBS tc “BBS” \l 2
General

“BBS can eat or not?”

BBS stands for Bulletin Board System, which is like a notice board where anyone can post questions on relevant topics and anyone can answer them. However, there are rules and regulations to adhere to and "newbies" are advised to read one of the folders, iscs.rules, first to familiarize themselves with some basic netiquette. The scope of topics in the BBS ranges from academic to entertainment.

How To Invoke Bbs

Type 'bbs' at the prompt

That's it!
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· There should be 4 fields on your screen.

a) Folder Number

b) Number of Articles (including follow-ups) posted in the folder

c) Name of the Folder

d) A Description of the Subject Covered by the Folder

· Help is available by pressing 'h'.

How To View Articles

There are many ways to navigate in the BBS; the most common is using the arrow keys.

· UP/DOWN - to select a folder
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RIGHT/LEFT - to go into/out of a folder

When a folder is selected, you will see a list of threads with 6 fields:

1. Thread Number

2. If there is a '+' sign, this means that there are articles in the thread that are not yet read

3. The Number of Articles in the thread

4. Length (in lines) in the Article which is not read

5. Name of Thread

6. Name of Person who posted the article

Again, you can use the arrow keys to navigate through the threads, and to select the article which you wish to view.

  Summary : Select Folder ( Select Thread ( Select Article    
How To Post (A New Thread) In BBS

1. Select the *relevant* folder which you want to post. (so your intended readers get to read your articles, and not someone else who isn't interested in what you have to say) Newbies are *strongly* encouraged to experiment in the folder iscs.test

2. Press 'w' to Post, 

3. Type in the Subject of your posting

4. Type in your article in the text editor which is automatically invoked.
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5. When you have finished, exit the text editor. You will be asked to q)uit, e)dit, i)spell, g)pgp, p)ost, or p(o)stpone. To post, press P or the Enter Key.

6. To view the article you just posted, you have to exit the folder first.

How To Follow Up As A Response To An Article

· Select the article which you wish to follow up

· There are 2 ways to follow up:

1. to include contents from the followed up article: Press 'f'

2. to exclude contents from the followed up article: Press 'F'

· Perform Steps 4-5 as above

How To Reply To The Author

· You may wish to make a reply to the author of an article only, instead of "making a statement" in the bbs.

I. Select the article which you wish to reply to the author

II. There are 2 kinds of replies:

· to include the article contents in your letter: Press 'r'

· to exclude the article contents in your letter: Press 'R'

III. Type in your letter in the text editor

IV. When you are finished, exit the text editor.

· You will be prompted to q)uit, e)dit, i)spell, g)pgp, s)end.

· To send your letter, Press 's' or the Enter Key.

How To Delete an Article

· If you accidentally posted an article when you don't intend to, you can delete the posting as follows:

I. Select the article which you wish to delete

II. Press the 'D' key. The article will be deleted from the BBS

· Note that you can only delete your own posting.

How To Change Your Name, Organization & Editor For BBS

· In your home directory, there is a .profile file. You will need to add the following in that file:

export EDITOR=XXXXX

export NAME="<whatever name>"

export ORGANIZATION="<whatever place>"

where XXXXX is your choice of a text editor (vi, vim, pico, joe, emacs etc), Do lurk around the BBS to see what has been used by the seniors, to avoid "name-conflict".

Common Mistakes

Check the iscs.rules folder to familiarize with the common rules. In addition to those in iscs.rules, here are some common mistakes made by BBS posters:

· Post in a wrong folder. 

Mistakenly post a message to an inappropriate folder. For example, you have some feedback to the system administrators regarding your Unix account. You post this message to the iscs.acad.level1 (It should have been iscs.feedback), then use “shift + d” to delete the message as soon as possible.

· Post an empty message.

 When mistakenly post an empty message on a folder, before receiving any warnings from the system administrator, use “shift + d” to delete it.

· Wrong message format.

When posting a new message into a folder (not to follow up others’ messages), the first line should be some simple greetings, such as “Hello,” and “Hi,”, then write your message on the next blank line. In case forgetting to do so, the message will not be accepted by BBS, which requires it to be edited again in order to be a successful post.

· Follow up useless messages

When following up messages, in the new posting, keep those previously posted message lines that are convenient for your need and delete the rest away, for the sake of easy reading.

Outlook Express

Outlook express can be configured to retrieve the news from the SoC server to the desktop. Please refer to the section on the dialup services for further details.

PINE

Pine can also be used to read news. From the Main Menu, choose L (for list of folders) and then select “News from SoC newsgroups”. 

FTP

FTP or file transfer protocol allows transferring of files from one system to another through a network. FTP works as a client/server process. The ftp command running on your system is the client to an FTP process that acts as server on a remote address. 

File transfer can be done through the windows based WS_FTP software, or by running the ftp command at the DOS prompt. Several other software packages that facilitate FTP are also available. 

WS_FTP

WS_FTP is a file transferring software that is easy to use and adds convenience to the use of the SoC UNIX accounts on the SUN machines.  It can be window-shopped from the NUSNET III or downloaded from the NUS Intranet I-drive.

Logging on

On double clicking the WS_FTP icon, a Session Properties window appears on which the username and password that are recognized by the remote server have to be entered. This is to authenticate the file transfer process. This window disappears once you are logged on, but can be accessed at any time by clicking on the Connect button at the bottom of the FTP window.
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For transferring files to or from the SoC servers, on the Session Properties/General window:

· Type in any reference name for the remote host or profile in the Profile Name field.

· In the Host Name/Address field, type in the remote server address:

· E.g. decunx.comp.nus.edu.sg

· Select Host Type to be Automatic Detect.

· Type in your SoC user id in the User Id field and click OK or press Enter.

· A new window for entering the password appears. Type in your password and click OK.

The logging on process is now complete and you will see the WS_FTP screen, with the contents of the local directory on the left and the remote home directory on the right. All the instructions executed through the FTP software are shown on a log window below the directory listings on the FTP screen. The contents of the log window can be viewed by scrolling or by clicking the LogWnd button at the bottom of the FTP screen. 

Changing directory for file transfer

The working directory can be changed by clicking on the Change Directory tab on whichever side the directory needs to be changed, i.e., either on the left for changing the local directory, or on the right for the remote directory. 

A window for changing directory appears as shown on the following page. Type in the desired directory path and click OK or press Enter.

[image: image27.png]MS-DOS Prompt - TELIX

decunx fctivate SLIP
Sununx Activate PP
sund Cfor staff users only)

sunts0 Show IP address
mpp CFujitsu AP3000/32)

TELHET ~ enter hostname

BLOGIN — enter hostname Info and Tips
Show current session Show users
Resume current session Testing
Disconnect current session Hangup

Logout q Repaint r
Enter number of selection or use arrou keys: 1





There are links to the other main drives of the system below the contents listing of the working directory. These can be directly accessed by double clicking them.

Transferring files

Before transferring files, set the transfer mode to either Binary or ASCII mode. This is done by checking the appropriate circle at the bottom of the FTP window. Binary mode is suitable when the file contains non-text data, such as images and movies. (Word and Excel documents are also considered non-text data). ASCII mode is recommended when the file is text based.

To transfer a file from the local directory to the remote directory or vice versa, do either of the following:

1. Double-click the filename on the FTP screen, (OR) 

2. Click on the desired filename and then press the appropriate arrow key between the local and remote directory listings. (Refer figure 2)

The file transfer process will be displayed as it takes place and the time taken, transfer speed and size of the file transferred will be displayed on completion. 

Other utilities on WS_FTP

Other than transferring files, FTP can also be used to make new directories, rename or delete files on the remote server or on the local workstation. For instance, to delete a file on the remote system just log on, click on the required file and click on the Delete button next to the directory listing on the FTP screen.

Thus WS_FTP allows complete access and control over files on a remote host.

To exit the FTP session, just click on the Exit button at the bottom of the FTP screen. This will log you off from the remote server and close the FTP window. 

DOS FTP

The ftp command can also be run on DOS to facilitate file transfer. This command on DOS is similar in use and syntax to the same command in UNIX. 

Just type ftp at the DOS prompt followed by the address of the remote host.

E.g. C:\> ftp decunx.comp.nus.edu.sg

Once connection to the remote host is established and you are logged on to the host, you are ready to start transferring files.

There are many commands under ftp that facilitate file transfer and file access at the remote host. The commands are typed in at the ftp prompt. Some of the basic commands are as follows:

1. ls – This command is used to view the directory listing on the remote host.

2. mls – This command is used to view the directory listing on the local workstation.

3.
cd – This command is used to change directory at the remote host. 

4.
lcd 
– This command is used to change the working directory on the local system.

5.
get 
– This command is used to get the required file from the remote to the local system. 

 E.g. get abc.xyz will get the file abc.xyz from the remote working directory and store it into the local directory.

6.
put 
– This command is used to transfer a file from the local system directory to the remote host working directory. 

Commands like delete, dir, open, type, rename, rmdir etc. work on the remote host files. The corresponding commands for delete and dir on the local system are mdelete and mdir. Help on ftp can be obtained using the command help for the local system and remotehelp for the remote host. Commands binary and ascii are used to choose the respective mode of transfer of data.
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        +---------+

+---+-->|  EDIT   |

|   ^   +---------+

|   |        |

|   |        |

|   |        v

|   |   +---------+

|   +---| COMPILE |

|       +---------+

|            |

|            |

|            v

|       +---------+

+-------|   RUN   |

        +---------+
1. Use an editor of your choice, type in the source code (filename must have extension .java, eg: inventory.java)


2. Compile your program to obtain the object file (with extension .class) by using the javac Java compiler. If there are compilation errors, identify them and re-edit the source code before you proceed.


3. Run your Java object file (default file extension .class) using the java command). 

  decunx:~/java0[xxx]$ java inventory

The user (for user id) and pwd (for password) commands are used to log on to the remote server. To exit the DOS ftp session, just type bye or quit at the prompt. 
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Compiling and Executing a Java Program

Setting up your Account

Enter the command pwd to print the current working directory. What is shown following the command is your home directory. 

Enter mkdir cs110l to create the directory cs1101 to store files used or created during the laboratory session. 

Enter cd cs1101 to change the current diretory to cs110l. 

Create one subdirectory of each laboratory session by entering mkdir labnn for nn = 01, 02, to 16. 

Running a Java Program

The process of creating a working Java program involves the following steps: 

If there are run-time errors, you must identify them and re-edit the source code, and compile again. 

A sample Java program

A sample Java program has been copied into your "java0" subdirectory. Use "cat" to view the program. 

tanhappy@decunx:~[xxx]$ cd java0

tanhappy@decunx:~/java0[xxx]$ cat square.java

import java.io.*;

class square {

  public static void main(String arg[])

    throws IOException {

     int n;

     BufferedReader stdin = new BufferedReader

     (new InputStreamReader (System.in));

    System.out.print ("Enter the number to be squared: ");

    n = Integer.parseInt (stdin.readLine());

    System.out.print("You typed in ");

    System.out.println(n);

    System.out.println();

    System.out.println("The square of " + n + " is " + Math.pow(n,2));

  }

}

Compile and run the program as follows: 

tanhappy@decunx:~/java0[xxx]$ javac square.java

(this will compile square.java and produce the byte code file square.class)

tanhappy@decunx:~/java0[xxx]$ java square

(this will execute the byte code file square.class)


Creating your own Java Program

Create your first Java program "first.java"

There are a number of editors available in decunx: vim, vi, emacs, joe, pico, etc. Some are more powerful than others, but take a longer time to learn. For this lab, you will use the simplest editor of all -- pico. It is YOUR responsibility to pick an editor and master it, and in future labs we will assume that you are familiar with your editor and its various functions. 

Get into your java0 subdirectory if you are not there. Enter "pico first.java" and type in the following program: 

class MyProgram {

   public static void main (String [] args) {

System.out.println(“It is my first Java Program.”);

System.out.println(“Amazing, isn’t it?”);

   }//end main

}//end class
When you are done, enter ctrl-x to exit from the pico editor. You will be asked to save the buffer. Type Y for yes and hit the [RETURN] key when the filename first.java appears (if you forgot to type in the filename first.java when you invoked pico earlier on, you must type it now). 

Compile and run your program

tanhappy@decunx:~/java0[xxx]$ javac MyProgram.java

There will be error messages if your program has errors. Go to Step 7.1 to make the necessary corrections and re-compile. If there are no compilation errors, proceed with program execution as follows: 

tanhappy@decunx:~/java0[xxx]$ java MyProgram
Another program

Use the instructions above to create, compile and run the following program Age.java. What is the output of the program? 

import java.io.*;

class Age {

   public static void main(String arg[]) throws IOException {

      int year;

      BufferedReader stdin = new BufferedReader

         (new InputStreamReader (System.in));

      System.out.println ("Enter the year when you were born: ");

         year = Integer.parseInt (stdin.readLine());


 int age=2000-year;

         System.out.println ("You are now "+age+" years old. " );

   }

}

The above program uses Integer.parseInt to convert a String to int so that we can do calculation on the input.

Java Development Kit

JDK, the java development kit, is a set of programs and packages designed to support the development of java programs. It can be installed on UNIX platform or MsDos. 

For most of our lab assignments in CS1101 (Programming Methodology), we would be using the MsDos environment. This means that we'll be using a compiler called Java Development Kit (JDK) to compile and run our programs.

Most of the machines in our Programming Labs on S15 Level 2, have already been pre-installed with JDK. 

1. Open a new notepad from your computer by going 

Start menu -> Programs -> Accessories -> Notepad

2. For illustration purposes, type the following program :

class first {

  public static void main(String arg[]) {

    System.out.print ("Hello World");

    System.out.println ("My first program works !");

  }

}

3. Go to File -> Save As... -> (select an appropriate directory) -> 

   File Name: first.java -> Save as type: All file (*.*)

4. From the Start menu, open up the program MS-DOS Prompt.

5. Depending on which directory your JDK has been previously saved and what version of JDK your computer is using, type:

   set path = %path%C:\jdk1.2\bin

6. Go to the directory you've saved your first.java.

7. To compile your program, first.java, type javac first.java.

 8. To run your program, first.java, type java first.

That's all! Have fun!!

Other Softwares for Developing Java Applications:

KAWA:  simple yet powerful

KAWA is an IDE (Integrated Development Environment) to build Java applications and applets on Win32 machines. KAWA supports Windows 95, Windows 98 and NT 4.0 platforms. We are serving the Java community since 1996 with some powerful tools and are committed to releasing stable and intuitive products.

KAWA is the most preferred Java development tool for individuals and companies committed to doing 100% pure Java development.

KAWA provides a powerful, easy to use and intuitive environment for Java development. KAWA is a wrapper on Sun's JDK and therefore 100% compatible with any JDK version. (1.0.X - 1.3 beta)

For more information about KAWA, please visit our Web site at: http:\\www.tek-tools.com\kawa

JAVA WORKSHOP 

Phone Numbers

8745356

8745357

8721547

8721548

8736377

8737906


Domain

comp.nus.edu.sg

Domain Nameservers

137.132.94.2

137.132.87.2

News  Server

news.ex.nus.edu.sg

(authentication using NT account and password)
POP Mail Server

stupophost.comp.nus.edu.sg

SMTP Server

stumailhost.comp.nus.edu.sg

SoC BBS

news.comp.nus.edu.sg

Proxy Server

http://proxy.nus.edu.sg:8080


Java WorkShopTM software is a powerful, visual development tool for professional programmers using JavaTM technology. It offers a complete, easy-to-use toolset for building Java technology-based applets and applications and components based on the JavaBeansTM architecture quickly and easily.

Java WorkShop 3.0.6 Community Edition binary code is currently available for free for use by developers.

You can download any of the following:  http://www.sun.com/workshop/java/


Dialup Services  tc “Dialup Services”
Overview tc “Overview” \l 2
There are altogether 216 dialup lines available for staff and students of DISCS. Some of the dialup lines connect to terminal servers.  This section of the guide deals with what to do when you are at the terminal screen.

Upon dialing in, you will be presented with a user-friendly menu via which you can:

1. Choose to telnet to our various workstations

2. Activate SLIP or PPP mode.

3. Read information and tips on dialup usage

Some Important Information

* A 1-hour connection-time limit is imposed; the dialup server will hang up the modem automatically upon the expiry of the time limit without giving any warning.

# These dialup lines connect to terminal servers.

Setting up PPP connection in Microsoft Windows 95 tc “Setting up PPP connection in Microsoft Windows 95” \l 2/98

Configuration

· Go to the control panel folder in your PC

· Click the Network icon

· Make sure that the proper network components are installed (TCP/IP)

· If not click the add button to install them. *

* for details on installing network components please refer to the following hyperlink:

http://www.comp.nus.edu.sg/facility/facilities/win95ppp.html

Making a New Connection

· Go to the Dialup Networking Directory

· Double click on the Make New Connection icon

· Go through the series of 3 screens

· Enter the appropriate information and click next on each of the screen

1. Enter any name you like, choose your modem and click next.

2. Enter the phone number and click next.

3. Click Finished

Configurating the Connection

· Right-click the new icon created and select 'Properties'

· Select 'Configure' and followed by 



·    Options' and make sure that "Bring up terminal window after dialing' is checked (ticked)

·    Click on the "Server Types" tab and fill in the server name and addresses, make sure the appropriate boxes are checked / unchecked.



I'm Ready to Dial!

· Double click on the new icon you've just created and click the "connect" button.

·   When a Terminal Screen pop up, first hit "Enter" and key in your user-id and password (you will not see anything appears when you enter your password)

When the main menu appears, enter "12" for PPP connection. Click "F7 continue" to activate PPP for your system. (after entering option "12" you will see some funny characters, but it's normal)



Dialup Services for Other Systems tc “Dialup Services for Other Systems” \l 2
· Use any communication program, eg Telix, Qmodem, Hyperterminal…etc  (usually comes with your modem), dial to one of the numbers in "Important Information"

· Hit "Enter" and key in your user-id and password.

· At the main menu, choose the corresponding system.

MISCELLANEOUS  

SPNP

X-win32 Configuration for SPNP

In the PC lab, every computer has the X-win32, which you can use to access the Unix server X-machine from a Windows platform. On SPNP, you can do so via X-win32 and SSH. Below is the detailed configuration for each step.

Downloading & Installing X-Win32 

Where to download: 

On your PC, you can use any FTP program to download the x-win413.exe file. If you are using a web browser such as Netscape or Internet Explorer, then you can download the file in one step by opening the URL 

ftp://username@ftp.comp.nus.edu.sg/dist/xwin32/4.1.3/x-win413.exe 

(Specify your own username instead of "username". Enter your password when prompted.) 

As an alternative, if you use a native FTP program, then you can retrieve that file as follows: 

C> ftp ftp.comp.nus.edu.sg
username: ..... (enter your SoC Unix account's username)
password: ..... (enter your SoC Unix account's password)
[Logged in]
FTP> cd /dist/xwin32/4.1.3/
FTP> binary
FTP> get x-win413.exe
FTP> quit
C>

For the latest version 4.1.4, you can download it from StarNet.com website, which is 

          http://www.starnet.com/productinfo/index.html  

What file to download: 

From our ftp server, you should download 

                         X-win413.exe 

From Starnet website, the file name after downloading is 

                        X-win414.exe

How to install: 

Run the x-win413.exe program on your PC, and following installation procedure as usual. 

When prompted to enter the license code, enter 

012dfa6448bd3ed1
This license code entitles you to run the Xwin32 program within the 137.132.0.0 network (i.e. NUS network). 

Installing & Configuring X-Win32 

1. Download and install X-Win32 as described above. 

2. After installing, start the program X-Util32. 

3. Go to options, windows settings, set to multiple 

4. Under options again, make sure access control is checked 

5. Click OK to continue 

Installing & Configuring Tera Term 

1. Download Tera Term at this location http://hp.vector.co.jp/authors/VA002416/teraterm.html 

2. Download SSH extensions at this location http://www.zip.com.au/~roca/ttssh.html 

3. Install Tera Term first, once its done, extract the ssh files to the Tera Term directory (Should be C:\Program Files\Ttermpro) 

4. Unzip it into the directory where you've already installed Teraterm 2.3. This will create files LIBEAY32.DLL, TTXSSH.DLL and TTSSH.EXE. 

5. Run "TTSSH.EXE" and the extension should be available. You should see a new "SSH" option in the "New Connection" dialog box and new menu items "Setup / SSH...", "Setup / SSH Authentication..." and "Help / About TTSSH...". 

6. Go to setup, TCP/IP, add the unix host names to connect here.  Click OK to continue 
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       Using X-Win32 with Tera Term 

1. Start your X-Win32 program 

2. Run TTSSH.exe, cancel the login screen, under setup, SSH forwarding, enable X Forwarding.  Click OK to continue 
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3. Under File, click New Connection, select SSH, port# is 22. Choose the unix host that you configured earlier.  Click OK to continue 
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4. Make sure "Use plain password to log in" is selected, to log in, enter your userid and password in the boxes 
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5. If you login to the host for the first time, you will see a security warning screen, click "Add this machine....." and click Continue 
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6. Once you have login, you are ready to start running your X applications 

7. To verify that your connection is working, run xclock in your TeraTerm client, you should see the window below in your computer desktop 
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         For more detailed information, you can find them at

                       http://www.comp.nus.edu.sg/cf/x/xwin32- spnp.html
Windows 2000 Network Configuration for SPNP

If you are using Windows 2000 Professional, here are some instructions for you to setup the network access via SPNP in campus.

· In case you only want to use the network instead of your H: and I: drive, as well as Windows Shopping and NUSNET III Printer Selection, every time you can logon as the Administrator. After you enter Windows, open your browser, IE or Netscape, go to 

             http://pnp.nus.edu.sg/ or

             http://spnp.nus.edu.sg/
     Use your userid and password to logon to the network. 

     However, there are some limitations. For example, every time you want to open a computer in My Network Place, you have to provide your NUSNET userid and password. i.e.

             Connect As: nusstu\(your userid)

             Password:   (your password)

· If you want to fully utilize your NUSNET account, such as the H: and I: drive, as well as nuscast TV programs, you have to logon as a member in the domain NUSSTU.

This is how you can do:

1. Send an email to Computer Center, tell them your computer’s name. 

2. After they reply your email, confirming your computer has been registered, then right mouse click on My Computer icon, Properties, choose Network Identification tag, click on Properties, choose Domain, change it to NUSSTU. Click on OK, and reboot your computer.

3. After the window prompting you enter the password to logon appears, click on button Options, change the Domain to NUSSTU, then you can connect use your userid and password. 

Setting up your Home Page

You can set up your own WWW (World-wide Web) pages through your SoC UNIX account and serve them through the SoC server at:


http://www.comp.nus.edu.sg/~userid
Know the basics of HTML 

You can get the basic information on HTML from the following URL. Use a WWW browser (e.g. lynx, Mosaic, netscape, IE) to access the website.

http://www.ncsa.uiuc.edu/General/Internet/WWW/HTMLPrimer.html

Read the following documents (in PostScript), either via ghostview/ghostscript or by printing to a postscript printer:


/usr/local/doc/www/html-primer.ps


                   html+.ps


                   url-primer.ps

A tutorial on HTML can be found on the lynx help files. Just run lynx and press h for help.

Set up your WWW directory and files.

· Create a subdirectory ~/public_html
       $ mkdir ~/public_html
· Create a file named index.html under your ~/public_html subdirectory, using any editor or html authoring tool.

This is the first file that is automatically served when someone connects to your home page. Build up the necessary links in your home page to point to your other pages.

Set up the correct permission for your directories/files.

· Make the path to your home page world executable, so that it is accessible from anywhere on the net.

From the root of your home directory downwards through your ~/public_html and any subdirectories, give x access on all these directories:

(drwx--x--x) 



$ chmod a+x ~/


e.g.
chmod 711 ~/


       
chmod 711 ~/public_html



chmod 711 ~/public_html/subdir

· Make your web pages readable.

This includes readable access to index.html and all other html files, image files etc. that you want to serve. Give r access for all those files:

(-rw-r--r--)



$ chmod a+r ~/
e.g. 
chmod 644 ~/public_html/index.html


chmod 644 ~/public_html/other-files

If you have a link to an image called "myself.jpg" in index.html, change directory to public.html or its relevant subdirectory, and then type: 



$ chmod a+r myself.jpg 

NOTE:  Setting the correct file permissions is VERY IMPORTANT. Incorrect setting will allow others to hack into your files or prevent them from accessing them altogether.


To verify permission settings

Verify your permission settings using the following UNIX commands:

$ cd ~/public_html

$ ls –la


You should see something like:


drwx--x--x  10 akashkum ce99 8192 Jun 16 14:50 .

drwx--x--x  41 akashkum ce99 8192 Aug  3 13:20 ..

-rw-r--r--  1  akashkum ce99 1021 Feb  8 13:46 index.html


Note that it is --x--x for directories; "." and "..", and r--r-- for normal files like index.html.


Now you have a global web presence! Your home page is accessible at: 

http://www.comp.nus.edu.sg/~userid

Test things out

Use a WWW browser to access your home page using the URL format mentioned above. If you encounter "Permission denied" errors, check the permission of your WWW directories and files.

Setting Up A Page Counter

· Include the line below in the html file you want the page counter to be in:
”<!--#exec cgi="/cgi-bin/pagecount"-->” (without quotes)
· Login to sununx (not other hosts). This is extremely important as no other hosts will work.

· At the prompt, type:

/usr/local/etc/httpd/cgi-bin/pagecount -h www.comp.nus.edu.sg   <target-file> 

Here <target-file> is the file you want to log on to, e.g. index.html

NOTE: ‘man pagecount’ (on sununx) for more details and options.


What to do when your profile storage space is exceeded?

Checking to see if you have exceeded your profile storage space

· Please logon to your NUSSTU account.

· Then click on the Start Menu -> Programs -> Windows NT Explorer.

· Now, go to this directory C:\ Winnt \ Profiles.

· Look for the folder of your userid (eg. isc12345)

· Highlight this folder by left-clicking it with your mouse button once. 

· Right-click your mouse button once and a little pop-up menu will appear. Select the option “Properties”.

If the “Size” of the folder is below 2 MB, you may choose to do nothing.


Otherwise, if this “Size” of the folder is above 2 MB, it means that you have exceeded your profile storage space, and deletion of some of your files is required.

Here is how to go about removing some of the unnecessary files inside your profile storage space.

1. Go back to your userid (eg. isc12345) folder by following the instructions as stated above. 

2. Double-click this folder with your left mouse button, to see an expansion of the contents inside your userid folder.

3. Look for the following sub-folders and delete all the file contents inside.

- Temporary Internet Files

- History

4. Check your profile storage space again to see if your profile storage space still exceeds 2 MB. Proceed to step 5 if more deletion of files is required.

5. In the midst of removing the unwanted contents of your userid folder, you may like to transfer some of the files to H:\isc12345 (replace 12345 with your 5-digit userid numbers) instead.

Here is how you can also go about preventing your profile storage space from being exceeded

      For Microsoft Internet Explorer (Version 4.0 and above) 

1. Double click the icon on the desktop of the Internet Explorer to open the program.

2. Go to Tools -> Internet Options… 

3. Under the “General” tab, select Settings -> Move Folder…

4. Change the directory to C:\ temp

5. Press OK and save the changes. 

For Netscape Communicator (Version 4.5 and above)

1. Double click the icon on the desktop of the Netscape Communicator to open the 

Program.

2. Go to Edit -> Preferences…

3. On the left column of the page, click once on the ‘+’ sign beside the Advanced option.

4. Click once on the option “Cache”.

5. On the right side of the page, change the Disk Cache Folder to C:\ temp.

6. Press OK and save the changes.

Upon realizing that your profile storage space has been exceeded, you may also choose to: 

Send an email to the NUS Computer Centre at ccehelp@nus.edu.sg, and request them to reset your profile for you.

*Note: Remember to backup an additional copy of your important documents, before you send this request.


UNIX Commands

QUICK REFERENCE

COMMAND
DESCRIPTION

alias [alias-term=["command-string"]]
Allows the entering of shorter or easy-to-remember names to execute longer or hard-to-remember commands.

at [-m] time [date]
Schedules a command to run at a particular time.

bc
A program to evaluate mathematical equations.

bg [job]
Continues a stopped job in the background.

cal [month] [year]
Displays calendar

cat [filename]
Displays the contents of the file named by filename.

cd [directory]
Change to another directory. Entering cd without the directory argument will move you to your home directory.

chmod permissions path
Changes the access permission associated with a file or directory 

chown username path
Changes the ownership of the file or directory, path, to user username.

cp file1 file2
Creates an identical copy of the file1, and names the copy file2. Note that the ownership of file2 will be set to whoever does the cp command.

date
Displays the current date and time.

diff file1 file2
Compares the contents of two text files and displays the differences. The lines preceded with < are from file1. The lines preceded by > are from file2. Each section of differences is separated by ---. 

du options
The du command summarizes disk usage. du entered on the command line with no options will return the size of all the directories beneath the current working directory

exit
Terminates the current UNIX shell.

fg
Continues a stopped job by running it in the foreground

finger user
Displays information about user accounts.

ftp
Connects to another computer to either get a file(s) from the remote machine or to put a file(s) onto a remote machine.

grep pattern file
Searches one or more files, specified by file, for the text string specified by pattern.

head file
Displays the first few lines of a file

jobs
Lists the jobs that are running in either the foreground or the background, and the jobs that are stopped.

kill [-9] pid
Terminates the process with the id-number pid.

less file
Displays the contents of the text file file a screenful at a time.

ln
Creates a link to a file so that it has more than one name or resides in more than one directory.

logout
Terminates the current UNIX session and log out of the system.

ls pattern
Lists the files and directories in a directory.

man command
Displays the standard UNIX manual page for the command you specify.

mkdir dir
creates a new directory named dir.

more file
Displays the contents of the text file file a screenful at a time

mv name1 name2
Moves and/or renames the file or directory, name1 to name2.

passwd
Changes your UNIX login password

ps
Displays a list of the processes currently running on the machine that you are logged into.

pwd
Displays the full path of your current working directory.

rm file
Removes the file file permanently from the filesystem. Note that deletion cannot be undone.

rmdir dir
Deletes the empty subdirectory dir.

talk user
Allows you to communicate with another user using your terminal.

tail file
Lists the last few lines of file.

telnet address
Logs into another machine specified by address. 

wc file
Counts the number of words or characters and lines in file.

who
Displays a list of who is logged on to the system and where they are logged on from


Interesting Unix Commands

Here are many other commands you may find more interesting.

COMMAND
                   DESCRIPTION

spy
Spy allows you to spy on the intended persons that you want to spy on. (Rather than the “who” command which will display all the logged on users) The userids & names of these people are stored in the file “name.dat” and the program will read and display from the file. This program will identify the userids, names, locations that the specified users are logged on to, in the same server. 

spy2
Spy2 is another version of spy, just that it displays only the task that the intended people who are logged on instead of displaying the location as in spy.

chat [userid]


Chat allows two persons who are logged on, to chat on the same server. It will bring out a chat interface for user to key in the dialogue. The recipient will receive a pop out message with name and userid from the user. It will require the user to know if the other party is logged on too, using spy or who. Then the user can initiate the chat and the other party must respond accordingly, otherwise, the chat will be one way.

Chat is in essence a user-to-user communication program. It allows you to send messages to another user a line at a time. Normally, establishing a talk connection might take quite a while and if you just need to say a few words to your friend, it will be quite meaningless to wait for such a talk connection. 

write [userid]
The write command allows you to converse with another user who is logged in.

When using write, there is a possibility of the other party typing on the same line as you are. You have to wait for the other party to finish typing before you can start typing.

ztalk [userid]
The talk command allows two users to enter text simultaneously into windows displayed on each other's terminals.  To initiate a conversation, one userexecutes talk and specifies the second user's username.

When the first user initiates the conversation, a message is sent to the second user.  If the first user also specifies tty_name, the invitation message is sent to the specified terminal.  Otherwise, the invitation is sent to the terminal on the remote host on which the second user first logged in.  Once this invitation is received, talk displays two windows on the first user's terminal and displays progress messages until the second user responds to the initial message.

If the second user wants to have the conversation, the second user also executes talk from any terminal and specifies the first user's account name and hostname, if appropriate.  If the second user accepts the invitation, talk displays two windows on the second user's terminal.  One window displays what is typed by the local user; the other displays what is typed by the remote user.  To end the conversation and close the connection, either user can press the Interrupt key sequence.

ytalk [userid userid]
YTalk is in essence a multi-user chat program.  It works almost exactly like the UNIX talk program and even communicates with the same talk daemon(s), but YTalk allows for multiple connections.



mesg n/y
“mesg” is to reject messages. “mesg y” is to grant messages.

screen
Screen is a full-screen window manager that multiplexes a physical terminal between several processes (typically interactive shells). Each virtual terminal provides the functions of a DEC VT100 terminal and, in addition, several control functions from the ANSI X3.64 (ISO 6429) and ISO 2022 standards (e.g. insert/delete line and support for multiple character sets). There is a scroll back history buffer for each virtual terminal and a copy-and-paste mechanism that allows moving text regions between windows.

When screen is called, it creates a single window with a shell in it (or the specified command) and then gets out of your way so that you can use the program as you normally would.  Then, at any time, you can create new (full-screen) windows with other programs in them (including more shells), kill existing windows, view a list of windows, turn output logging on and off, copy-and-paste text between windows, view the scrollback history, switch between windows in whatever manner you wish, etc.  When a program terminates, screen (per default) kills the window that contained it.  If this window was in the foreground, the display switches to the previous window; if none are left, screen exits.



photofinger  [userid]
Displays the photo of a user with finger information. (photofinger is a  program that displays the photo of a user(s) in addition to the usual finger infomation. Photos can only be displayed on X window.

staff  [staffid]
Allows you to search for another staff's email address, office number, telephone number and other particulars.

W [userid]
Display information about currently logged-in users. What each user is doing, The fields displayed are: the user's login name, the name of     the tty the user is on, the time of day the user logged on (in hours minutes), the idle time-that  is,  the number of minutes   since   the   user   last typed anything (in hours & minutes), the CPU time used by all processes and their children on that terminal (in minutes:seconds), the CPU time used by the currently active processes (in minutes:seconds), and the name and arguments of the current process.

pilot
Unix browser that allows you to browse the files in your directories like in the window explorer/ Norton nc.

banner + [any string]
A command helps you to get the enlarged view of the string you entered after it. 

micq
A more convenient and useful communication tool in Unix than chat and talk. Enter this command, then your PIN and password. Then you can exchange messages with your friends.  
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Password:
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250 CWD command successful

ftp> cd unixGuide
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